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1. Tool Bar, Legend Bar, Action Panel 

By checking or un-checking Tool Bar, Legend Bar, and Action Panel under View, MiniTool 

Partition Wizard can show or hide these items. If the screen resolution of the computer is low, 

users can hide them to enlarge the area of Disk/Partition List. 
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2. Disk Map Location 

The location of disk map can be changed from the top to the bottom or from the bottom to the top, 

and users can complete these changes as the following screenshot shows: 
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 If users check Top instead of Bottom, the disk map will show as below: 
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On the contrary, if users choose Bottom for disk map location, the disk map will show as below: 
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3. Change Font 

3.1 About Change Font 

Change Font is under the View menu at the top of the software interface, allowing user to change 

font and font size freely. All available font types are those provided by OS. 

3.2 How to Change Font 

Step 1. Launch MiniTool Partition Wizard to enter the main interface as follows. Click the 

item View on the top and choose Change Font. 
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Step 2. A pop-up window will show up as follows. Here users can change Font, Font 

Style and Size, and then view the effect in the lower-right side Sample box. Click OK to 

continue. 
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Step 3. The software will exist and then run automatically. At last, users will see the main interface 

with font changed. 
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4. Main Window 

MiniTool Partition Wizard has a user-friendly main window, which is composed of six parts: 

1. Menu Bar: General, View, Disk, Partition, Dynamic Disk, Wizard and Help are included 

here.  

2. Tool Bar: some of the common functions are listed here.  

3. Action Panel: Wizards and Partition Operations (or Disk Operations) are included. It also 

shows the pending operations that haven’t been carried out yet. 

4. Disk/Partition/Volume List: shows all the disks and partitions in computer as well as the 

detailed information about them. All the following data are included:  

⚫ Drive letter and partition label (If a partition has no drive letter, * will be showed); 

⚫ Total capacity of partition; 

⚫ Used space in the partition; 

⚫ Unused space in the partition; 

⚫ Type of file system; 
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⚫ Type of partition; 

⚫ Status of partition (Active means the partition is an active main partition; Boot means the 

system boots from this partition; System means this partition is where Windows is located; 

and Hidden means the partition is a hidden partition).  

5. Disk Map: it gives users an intuitive preview of the partitions and unallocated space on disk.  

6. Legend Bar: different kinds of legends are displayed here with various colors and 

corresponding explanations.  

 

After selecting a partition or disk in Disk/Partition/Volume List, users can carry out 

any of the functions listed in top Partition menu or Disk (Dynamic Disk) 

menu, Tool Bar, Action Panel or the context menu appeared after right click of 

mouse.  

5. Disk & Partition 

After starting the MiniTool Partition Wizard, users can select the disk or partition they want to 

manage directly from the Disk/Partition/Volume List. 

https://www.minitool.com/lib/disk.html
https://www.minitool.com/lib/disk-partition.html
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Attention: 

⚫ MiniTool Partition Wizard Free Edition does not support the management of volume and 

dynamic disks. It only supports basic disks of MBR style and GPT style.  

⚫ MiniTool Partition Wizard support removable disks well like USB or external disks. 

6. Select an Operation 

Users can right click on a partition or disk to manage it. They can also select one function from the 

top Partition menu or Disk (Dynamic Disk) menu after selecting the partition or disk. The most 

direct way to manage a partition or disk is to choose function from Action Panel after selecting 

the partition or disk. 
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What users should pay attention to is that the partition operations are effective only when a 

partition is chosen.  

Similarly, if users choose a disk, only disk operations will appear in Action Panel. 
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Most of the time, users need to click on Apply button in Tool Bar to complete management in 

MiniTool Partition Wizard 

7. Apply Changes 

Most of the time, MiniTool Partition Wizard will not perform any change unless users make sure 

to Apply Changes, and all changes will be listed in Operations Pending area, which provides 

users with a chance to check whether there are operations damaging data. 
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To apply pending operations, users have 3 choices: 

1. Click on the functional button Apply in the upper left corner. 
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2. Choose Apply Changes from the drop-down menu of General menu.  
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3. Make use of the combination keys Ctrl + A.  

Moreover, sometimes users will be asked to restart the computer after they apply all changes. That 

is because they are operating the device which is being used. Just do as told and MiniTool 

Partition Wizard will perform all unfinished operations in safe boot mode. After all operations are 

completed, the computer will start normally. 

8. Discard All Changes 

With this feature, users can discard all previous changes to disks and partitions in one go rather 

than cancel the last one. Users can activate this feature via the following 3 ways: 

1. Choose Discard button at the top directly. 

 

2. Select Discard All Changes from the drop-down list of General item. 
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3. Make use of shortcut keys Ctrl + D. 

9. Exit  

To exit from MiniTool Partition Wizard, users have 2 choices. One is to choose Exit from the 

drop-down list of General item, and the other is to click on the close button at the top-right corner 

of the window.  



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

10. Reload Disk  

If users have made changes on disks or partitions but MiniTool Partition Wizard does not detect 

such changes, they can manually reload disk and partition information via the Reload Disk feature, 

which is located under the General tab. 
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11. Undo Last Changes  

With Undo feature, users can cancel the last operation to a partition or disk without having any 

influence on data, and it can be activated via the following 3 ways: 

1. Choose Undo button directly from the toolbar. 
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2. Choose "Undo Last Changes" from the drop-down list of General item. 
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3. Make use of the shortcut keys Ctrl + Z. 

To cancel all changes, users need to employ the feature Discard. 

 

12. Help 

The Help item in Menu Bar has 6 broad items as following: 

1. FAQ: Go to Help > FAQ and users will enter a website which shows them how to use this 

software to solve some common disk or partition issues.  
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2. Contents: Go to Help > Contents F1 or press on F1, and users will get the interface where all 

functional tutorials of this program are shown. 
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3. Contact Us: Go to Help> Contact Us, users can contact MiniTool Partition Wizard’s technical 

support directly to get help. 
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4. Checking for Upgrade: Go to Help > Checking for upgrade, and this software will check 

whether there is a new version available or not. 

 

5. Enter License Key: If users purchase a license key from the official site, they should go 

to Help > Enter License key and enter the pop-out interface to register for the corresponding 

edition. 
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6. Debug Help: 

1). Export Log: Go to Help > Debug Help > Export Log to export the log of operations and 

save it to the specified path. 

Step 1. Go to Help > Debug Help > Export Log. 
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Step 2. Choose a proper storage path, set the file name and then click on Save. 

 

At last, the log will be stored on the specified path. 
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2). Export Disk Configuration: 

Step 1. Go to Help > Debug Help > Export disk configuration. 

 

Step 2. Select a proper path to store this disk configuration and set a name for it on this pop-out 

interface. Then click on Save. 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

The disk configuration will be stored on the specified path. 

3). Make Screenshot: 

Step 1. Go to Help > Debug Help > Make Screenshot. 
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Step 2. Click on Save Screenshot to continue.  
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Step 3. In this second pop-out window, select a storage path, add a name for the screenshot and 

then click on Save. The screenshot will be stored in the specified path finally.  

 

4). Make Debug Image: 

This function will help users to create a partition image for debugging purpose. The created image 

file will contain the file system information only. It supports NTFS file system only. 

Step 1. Go to Help > Debug Help > Make Debug Image. 
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Step 2. Click on Browse button. There will be a pop-out window which enables users to choose a 

proper stored path and set the file name. Then press on Save to continue. 

 

Step 3. Click on Start! and this software will start the debug image making process. Just press 
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on OK when this process is finished. Then, the debug image will be saved on the specified path. 

 

5). Restore Debug Image: 

This function will help users to restore debug image file to a partition for debug purpose and just 

support NTFS file system. 

Step 1. Go to Help > Debug Help > Restore Debug Image. 
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Step 2. Click on Browse button on the pop-out window. 

 

Step 3. Pick the target debug image from the computer on this second pop-out window and then 

press on Open to continue. 
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Step 4. Select a partition from this interface, click on Start! and then press on Yes from the 

pop-out window to start the restoring process. 
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Step 5. Click on OK when the restoring process is finished. 

6). Export NTFS File Record: This function will help users to export NTFS file record. 

Step 1. Go to Help > Debug > Export NTFS File Record. 

 

Step 2. Select a folder to store the exported file. Then click Select Folder. 

Note: The selected partition should have enough space for restoring debug image. 
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Step 3. Select a partition from this interface, click on OK from the pop-out window. 

 

7). About: Go to Help > About, and users will see a pop-out window as follows, which will show 

them some information about this software such as building date, building time, and copyright. 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

13. Offline Activation  

13.1 Offline Activation 

Usually, after installing MiniTool Partition Wizard paid edition, we just input the license key to the 

Registration box, click Register button and then we have finished online registration. 

But if computer is not connected to the Internet, users will definitely receive the Offline 

Registration window. At this time, users should make their PC network connected. Otherwise, 

users will have to go through the offline license activation. 

13.2 How to Do the Offline Activation 

Step 1. Launch MiniTool Partition Wizard and click Register. 

Tip: Users may copy the key information to a removable disk to get through all the steps 

quickly. 

https://www.partitionwizard.com/help/offline-activation.html#offline-activation-56
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Step 2. Input the license key and and click Register. 
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Step 3. Connect the removable disk to the computer without network connection, open it and 

create a new Text document. Then copy the three URLs as well as the License Information and 

save them to the Text document. Now safely remove the removable disk and leave the Offline 

Activation window there. 

 

Step 4. Connect the removable disk to a networked computer and open the Text document. 

Now visit one of the three URLs listed.Then copy the License Information from the Text 

document and paste it into the box shown on the page users visit. Finally, click Activate button.  
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Step 5. And then users will get a Activation Code. Sometimes, users will be required to enter the 

Security Code after pressing Activate. Do this and again click Activate. Now the Activation Code 

is generated. Please save this code to the Text document for next process and finally remove the 

removable disk safely. 
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Step 6. Connect the removable disk back to the orginal computer, copy the Activation Code 

from the Text document and paste it into the box of Offline Activation. 

Step 7. Then click Activate button. Now users should have finished MiniTool Partition Wizard 

offline register. 
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Step 8. Click OK. 
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14. Create Partition 

14.1 About Create Partition 

Create Partition feature enables users to create a new volume with specified unallocated space. 

For users who have two partitions on the same drive, with one for the operating system and the 

rest one for personal data, perhaps the partitions can’t meet their demands for data management. 

In this case, Create Partition feature make it easy to manage various data by category.  

14.2 How to Create Partition on Windows 10/8/7 

For Windows 10/8/7 user, they can use a free partition manager - MiniTool Partition Wizard to 

create partition easily. Step-by-step guide is shown below: 

Step 1. Choose one of the following ways to activate Create Partition function: 

⚫ Click Create Partition from the left menu after selecting the unallocated space. 

⚫ Right-click on the unallocated space and choose Create option from drop-down menu.  

 

Step 2: In this interface, you are expected to confirm parameters including Partition Label, 

https://www.minitool.com/lib/hard-disk-partition.html
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Partition Type, Drive Letter, File System, Cluster Size, Partition Volume, Partition Location and 

Partition Alignment Method. 

Kind Remind: 

⚫ The partition alignment option is only available when users are creating the first partition on 

an MBR disk. 

⚫ Aligning to cylinder is used in older OS versions like Windows XP and Windows Vista; 

newer Microsoft OS versions and Linux use the MB alignment by default. 

⚫ For a logical partition aligning to cylinder, there will be 8 MB unallocated space; but for a 

primary partition aligning to cylinder, there won't be 8 MB unallocated space. 

With no change here, all these parameters are kept by default. After that, click OK button to go 

back to the main interface of the software. 

 

Recommended: 

⚫ Primary Partition vs. Logical Drive: Their Exact Features 

⚫ What Is FAT32 Partition Size Limit and How to Break It? 

Step 3: users can preview a new partition will be created. Click Apply button on the upper left 

corner to confirm the creation. 

https://www.partitionwizard.com/partitionmanager/primary-partition-vs-logical-drive.html
https://www.partitionwizard.com/convertpartition/fat32-partition-size-limit.html
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Kindly Remind: 

⚫ MiniTool Partition Wizard can be used to create 

FAT/FAT32/exFAT/NTFS/Ext2/Ext3/Ext4/Linux Swap/Unformatted partitions. 

⚫ This software is also helpful in creating FAT32 partitions larger than 32 GB, which can't be 

done in Disk Management. If there is no unallocated space available for creation, 

try Move/Resize Partition to release some free space, and then create a new partition. 

⚫ For Windows Server users, MiniTool Partition Wizard Server is the right choice. 

 

15. Delete Partition  

15.1 About Delete Partition 

Delete Partition feature enables users to remove a specified partition. For users who want to 

remove all partitions on the same disk, Delete All Partitions is more convenient. 

https://www.partitionwizard.com/help/resize-partition.html
https://www.partitionwizard.com/partition-manager-server.html
https://www.partitionwizard.com/help/delete-all-partitions.html
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15.2 How to Delete Partition 

Step 1. Choose a preferred way to activate partition deleting feature among the listed ones: 

⚫ Choose target partition and then click Delete Partition from left action panel.  

⚫ Select partition to be removed from the disk and click Partition on the menu bar, then 

select Delete. 

⚫ Right click target partition and click Delete from the context menu. 

 

Step 2. Click Apply and tap Yes button to let the software perform deleting operation. 

Note: In Windows 10/8/7, if users plan to delete system partition or the partition which 

contains page files, crash dump files, and hibernation files, please use MiniTool Partition 

Wizard Professional Edition to create a bootable disc, boot computer from this disc and then 

delete that partition in WinPE environment. For more information, click here. 

https://www.minitool.com/lib/system-partition.html
https://www.partitionwizard.com/partitionmagic/delete-active-system-partition.html
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With the help of MiniTool Partition Wizard tutorial, users can easily get unneeded partition 

removed. 

16. Format Partition  

16.1 About Format Partition 

With Format Partition feature, users can clear partition data and then reconfigure parameters for 

the specified partition so as to meet actual demands.  

 

16.2 How to Format Partition 

Step 1. Launch MiniTool Partition Wizard to get the following interface. Then, select the partition 

which needs formatting and choose Format Partition feature from the left panel. 

Warning: Formatting will destroy all data in the target partition. If the system partition or boot 

partition is formatted, the current OS will fail to boot properly.  



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

Step 2. Set partition label, file system and cluster size for the selected partition and click OK. 

 

https://www.minitool.com/lib/cluster.html
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Step 3. Now users can preview the formatted partition. If it is satisfying, please click Apply button 

at the top to apply the change. 

 

Corresponding MiniTool Partition Wizard tutorial for partition reformatting is demonstrated as 

above. 

17. Merge Partition  

17.1 About Merge Partition 

Merge Partition function helps users merge two adjacent partitions. It is noteworthy that this 

function only works for NTFS partitions. If the target partition is formatted with 

FAT12/FAT16/FAT32 file system, please use Convert FAT to NTFS function of the software to 

convert the partition to NTFS at first. 

17.2 How to Merge Partition 

Please view the MiniTool Partition Wizard tutorial for partition incorporation here: 

Step 1: Choose a preferred way to start partition merging operation from the listed ones: 

https://www.minitool.com/lib/file-system.html
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⚫ Select the source partition and click Merge Partition from left action panel.  

⚫ Select the source partition and click Partition from the menu bar. Then, click Merge from 

the drop-down menu.  

⚫ Right click source partition and click Merge from the drop-up menu.  

 

Step 2: In this interface, users can find the software has specified the selected partition to be 

expanded already. So users only need to click Next button to continue. 
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Step 3: Here, choose the partition which will be included in the previously chosen partition and 

name the folder which will contain the content of the selected partition. After that, 

click Finish button to go back to the main interface of the software. 
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Step 4: In the main interface, check the partition merging effect. If it is as expected, users can 

click Apply button in the upper left corner to confirm. 
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18. Split partition  

18.1 About Split Partition 

Split Partition feature allows users to split one big partition into two smaller partitions without 

data loss. If users have got a big partition which has a lot of free space, they can use this feature to 

divide it into multiple partitions for a better data classification. 

18.2 How to Split Partition 

To successfully get a partition split with this partition manager, users need to strictly follow the 

MiniTool Partition Wizard tutorial below: 

Step 1. From the main interface of this partitioning software, select the partition to split, and then 

click Split Partition from the action panel OR click Split from the drop-down list 

of Partition menu. 

Tip: To merge C drive and other partition, for a successful boot, users are strongly suggested 

using Extend Partition feature of MiniTool Partition Wizard Bootable Edition to do this job. 

https://www.partitionwizard.com/help/extend-partition.html
https://www.partitionwizard.com/partition-wizard-bootable-cd.html
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Step 2. Drag the slider bar leftwards or rightwards to determine the size of the original partition 

and new partition. After that, click OK button to go back to the main interface of the software. 
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Step 3: Back to the main interface, users can see that original partition has been split into two 

partitions. If certain preview effect is satisfying, click Apply button to take effect.  

Tip: Read the post No Free MBR Slots if MiniTool Partition Wizard cannot split the partition. 

https://www.partitionwizard.com/partitionmagic/no-free-mbr-slots.html
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19. Move/Resize Partition 

19.1 About Move/Resize Partition 

Move/Resize Partition is capable of changing partition size and location in Windows with ease. It 

helps: 

1. Enlarge a small partition or shrink a large partition when Windows Disk Management tool does 

not offer Extend Volume and Shrink Volume features. 

2. Extend or shrink a FAT partition in Windows Vista, Windows 7, Windows Server 2008, etc. 

3. Extend a partition to the left contiguous unallocated or free space. 

4. Extend a primary partition to contiguous free space. 

5. Move unallocated or free space to be contiguous to the partition users need to extend. 

19.2 How to Move/Resize Partition 

In general, Move/Resize Partition contains 3 operations – shrink partition, extend partition, and 

move partition. Let’s see these operations in detail. 
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Step 1. After successful installation, please launch MiniTool Partition Wizard to get its main 

interface. 

Step 2. Select the partition to operate and activate Move/Resize Partition from the left action 

panel or choose Move/Resize from right-click menu.  

 

Step 3. The blue handle represents partition while the blank area means unallocated space. Do the 

followings and click OK to go back to the main interface. 

⚫ To shrink a partition, shorten the handle by dragging the triangles. 

⚫ To extend a partition, lengthen the handle to occupy more unallocated space. 

⚫ Alternatively, users can manually type specified partition size in MB, GB, or TB. 
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To move a partition, drag the whole partition handle towards unallocated space or manually define 

unallocated space before or after the partition. 
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Step 4. From the main interface, users can preview that the selected partition has changed its 

position. At this time, please click Apply button in the upper left corner to apply the change.  

 

This is the end of the tutorial on Move/Resize Partition feature in MiniTool Partition Wizard. 

20. Extend Partition  

20.1 About Extend Partition 

Extend Partition directly takes free space from any other existing partitions or unallocated space 

to enlarge a partition on the same disk while Move/Resize Partition requires contiguous 

unallocated space. Under the following 2 situations, Extend Partition is suggested. 

1. Extend a partition to non-contiguous unallocated or free space. 

2. There is no unallocated or free space on the disk. 

Note: In Move/Resize Partition interface, users can see the option Using Enhanced Data 

Protecting Mode which is checked by default. Please keep it checked since it gives the 

strongest protection to our data. 
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20.2 How to Extend Partition 

Step 1. Run MiniTool Partition Wizard to get its main interface. Then, select the partition which 

needs extending and choose Extend Partition from the left action panel or choose Extend from 

the right-click menu. 

 

Step 2. Open the drop-down list of Take Free Space from and choose a partition or unallocated 

space to take free space. Then, drag the sliding handle leftwards or rightwards to decide how much 

space to take, with partition size changing intuitively. After that, click OK to continue. 
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Step 3. Click Apply button at the top to apply changes. 
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This is the end of MiniTool Partition Wizard Tutorial to Extend Partition. 

21. Copy Partition 

21.1 Copy Partition Wizard 

Copy Partition Wizard feature copies all data from one partition to another without any data loss 

with ease. Compared with copying files directly, to copy partition helps users save much time. 

Therefore, when users plan to backup files saved in one partition, try copying the whole partition. 

When MiniTool Partition Wizard is copying partition, data protection solutions such as power-off 

protection is activated automatically. Don’t worry about data security even if power outage 

emerges without redundant power supply. 

21.2 How to Copy Partition 

Step 1. Run MiniTool Partition Wizard to enter its main interface. Then, choose Copy 

Partition Wizard feature from the left action panel. 

 

Step 2. Click Next button to continue. 
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Step 3. Select the partition to copy. 
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Step 4. Choose an unallocated space from partition list to save the copy of the selected partition 

and then click Next.  

  
Note: Unallocated space should be large enough to hold all data on the source partition. 
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Step 5. Move the handle to enlarge or shrink the new partition. Alternatively, users can type exact 

partition size in MB. In addition, they can choose partition type (primary or logical) for the new 

partition. Then, click Finish.  
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Step 6. Click Apply button to make changes performed. 

Tip: The option Copy the partition with resize makes it possible to change partition size, so 

please keep it checked if users want to resize partition. 
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22. Wipe Partition  

22.1 About Wipe Partition 

Wipe Partition feature in MiniTool Partition Wizard can erase all data on the specified partition 

permanently, and the erased data can't be recovered by any data recovery solution. Therefore, 

wiping partition is quite a good way to prevent privacy or confidential information from being 

leaked. 

To wipe a whole disk, please refer to Wipe Disk feature. 

MiniTool Partition Wizard tutorial below will show you detailed steps. 

22.2 How to Wipe Partition 

Step 1. Launch MiniTool Partition Wizard to get its main interface as follows. Then select the 

target partition and choose Wipe Partition from the left action panel or right-click menu. 

Note: If users want to copy system partition, for a successful boot, it is recommended to 

use Copy Disk or Migrate OS to SSD/HD feature. 

https://www.partitionwizard.com/help/wipe-disk.html
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Step 2. Select a wiping method and click OK to go back to the main interface. The more time 

wiping process takes, the higher security it enjoys. 
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Step 3. Users can preview that the target partition is shown as Unformatted state. Then 

click Apply to start wiping partition. 
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When finished, the target partition is shown as unformatted and has no drive letter. 

Then users can format it and add a drive letter for it with these two features: Format 

Partition and Change Drive Letter.  

23. Align Partition  

23.1 About Align Partition 

The Align Partition feature added in MiniTool Partition Wizard helps users align the 

specified partition in several simple steps.   

23.1.1 Why Align Partition 

4K alignment is a quite important issue for hard disks which employ 4K sectors, including both 

Solid State Drive (SSD) and advanced formatted mechanical hard disk. And actually, it refers to 

the alignment between 4K physical sector and cluster. 

https://www.partitionwizard.com/help/format-partition.html
https://www.partitionwizard.com/help/format-partition.html
https://www.partitionwizard.com/help/change-letter.html
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When we are creating partitions on hard disks which use 4K physical sector, the partition always 

does not start from the starting position of a physical sector, which means physical sector and 

cluster will be shifted. 

 

As a result, reading data saved in one cluster will access 2 physical sectors, thus increasing access 

time or slowing down read speed. Similarly, writing a file will operate 2 physical sectors at least, 

which definitely will increase writing times and waste disk space. Therefore, it is very necessary 

to perform the 4K alignment. 

23.1.2 When Do We Need to Align Partition 

1. If users are creating partitions on SSD or advanced formatted HDD under old versions of 

Windows, including Windows XP, Windows Server 2003, Windows 2000, etc., partition alignment 

is required since these operating systems do not have such a function. 

2. After copying a partition to SSD or advanced formatted HDD, or after changing the location 

and size of a partition, users are suggested to align partitions, even if they are running Windows 

Vista or more advanced Windows operating systems in which partitions are aligned automatically 

when they are creating or formatting partition. 

For specific steps, please see MiniTool Partition Wizard Tutorial below. 

23.2 How to Align Partition 

Step 1. Run MiniTool Partition Wizard to get its main interface.  

Step 2. Select the partition which needs aligning, and then choose Align Partition from the left 

action panel or select Align from right-click menu.  

A cluster is the smallest logical amount of disk space that can be allocated to hold a file. One 

cluster can only hold content of one file no matter how small the file is. 

                                                               From Wikipedia 
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Step 3. If it is misaligned, uses will see a pending operation on the left action pane. At this time, 

just click on Apply button to perform this operation. 
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But if the selected partition is already aligned, users will get the information below.  

 

After that, partition alignment is completed via MiniTool Partition Wizard. It is so easy. However, 
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to align multiple partitions on the same hard disk, please use Align All Partitions feature. 

24. Check Partition File System  

24.1 About Check File System 

When running computer, users may receive a message that indicates there is a damaged file 

system or the partition need formatting before access which might be caused by abnormal 

shutdown. At this time, users may try to repair the error by employing the Check File 

System function which aims to checking and repairing some mistakes to ensure the integrity of 

the file. 

See the MiniTool Partition Wizard Tutorial to know how to complete this task.  

24.2 How to Check File System 

Step 1. Launch MiniTool Partition Wizard to its main interface. Then select the target partition, 

and choose Check File System from the action panel or from the Partition menu. 

 

Note: This function can only be used when the selected partition has a drive letter. For the 

partition without a drive letter, users need to appoint drive letter before they can use this 

function. 

https://www.partitionwizard.com/help/align-all-partitions.html
https://www.minitool.com/lib/file-system.html
https://www.minitool.com/lib/file-system.html
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Step 2. A new window pops-up with two options: Check only and Check & fix detected errors. 

If users only want to check, select the former one; if users want to repair mistakes during the 

checking process, select the latter one. After that, click Start button and MiniTool Partition 

Wizard will check/fix file system immediately. 

 

25. Change Drive Letter  

25.1 About Change Drive Letter 

Change Drive Letter feature is most commonly used in 2 cases: 

⚫ The drive letters of the multiple partitions are not arranged in sequence. 

⚫ Without drive letter, a partition would not appear in File Explorer. Change Drive Letter is 

able to reassign drive letter to that partition to make it accessible. 

25.2 How to Change Drive Letter 

You can easily change drive letter for partitions with MiniTool Partition Wizard. Launch this 

partition manager to its main interface to change drive letter. 

Step 1. Right-click on the target partition, and then select Change Letter in the pop-up menu. Or 

users can click Change Drive Letter feature from the left action pane after selecting the target 

https://www.minitool.com/lib/drive-letter.html
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drive. 
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Step 2. Then choose a drive letter from the list. Click OK to go back to the main interface.  

 

Step 3: Click Apply button to perform this operation. 

Note:  MiniTool Partition Wizard doesn't allow changing drive letter of the system partition.  
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26. Set Label 

26.1 About Change Partition Label 

Partition label is an optional name assigned to a partition to help users identify a certain partition 

quickly. Although partition label is not required, it makes it easier to keep track of what data is 

stored on each partition, especially when users have got many partitions. 

Once the data saved in a partition are not matched with the partition label (for instance, the 

partition which is used to store working files is labeled Game), users can change it. 

26.2 How to Change Partition Label 

Step 1. Select the target partition, and click Set Label from the Partition Management group of the 

left action panel or click Label from the submenu of Partition. 
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Step 2. A dialog box appears. Now, users can label/relabel the selected partition, and then 

click OK button to go back to the main interface. 
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Step 3. Finally, click Apply to execute all changes. 

 

27. Change Cluster Size  

27.1 About Change Cluster Size 

As we know, cluster is the smallest logical unit of disk space that can be allocated to hold and 

manage a file in Windows operating systems. One cluster can only hold one file, but one file can 

take up multiple clusters. 

If users save large files to file system with small clusters, data read-write speed will be reduced. If 

they save small files to file system with large clusters, a lot of disk space will be wasted. Therefore, 

it is very necessary to change cluster size reasonably, and Change Cluster Size feature in MiniTool 

Partition Wizard can help do this operation with ease. 

https://www.minitool.com/lib/cluster.html
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27.2 How to Change Cluster Size 

Step 1. Launch MiniTool Partition Wizard, then select the partition whose cluster size is not 

reasonable and choose Change Cluster Size from the left pane. 

 

Step 2. Choose a suitable cluster size from the drop-down list and click Yes to go back to the main 

interface. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3. Click Apply button on the top to perform pending operations. 
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Tricks 

1. If the purpose of increasing cluster size is to break the 16TB partition size limit, users can 

extend this partition directly with the Move/Resize Partition or Extend Partition feature. During 

this process, MiniTool Partition Wizard will increase cluster size automatically. With the added 

free space, the program should complete the increasing faster. 

2. If the partition doesn't have much free space left, MiniTool Partition Wizard may fail to change 

cluster size. In this case, we suggest extending the partition first, and then change cluster size 

manually. 

28. Change Serial Number  

28.1 About Change Partition Serial Number 

Partition serial number is a unique number assigned to hard drive during the creation of file 

system. It originated in the 1950s in the mainframe computer operating system. In FAT and NTFS 

file systems, partition serial number is a feature used to determine if the disk is present in a drive, 

and to detect if it was exchanged with another one. 

The serial number is a 32-bit number determined by the date and time on the real-time clock on 

the current computer at the time of a disk’s formatting. If the serial number is discrete, users can 

change it. And, MiniTool Partition Wizard is the best choice to complete this operation. 

28.2 How to Change Partition Serial Number 

MiniTool Partition Wizard Tutorial offers the detailed operation steps as follows: 

Step 1. Select the target partition, and then click Change Serial Number from the Partition 

Management group of the left action panel or from right-click menu. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/help/resize-partition.html
https://www.partitionwizard.com/help/extend-partition.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 2. Input new serial number in the new window and click Yes to go back to the main interface. 
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Step 3. Click Apply button on the toolbar to execute this change. 

 

When all operations are done, users can view new partition serial number by clicking the partition 

and choosing Properties. 

29. Change Partition Type ID  

29.1 About Change Partition Type ID 

For MBR-style partition, each partition has one partition type ID, so the system can tell the type of 

partitions by the ID. There are many partition type IDs, and the following IDs are frequently used: 

⚫ 0x07 NTFS 

⚫ 0x0B FAT32, used by DOS & Win95 

⚫ 0x0C FAT32 using LBA mode to access to FAT32 partition 

⚫ 0x01 FAT12 

⚫ 0x04 FAT16, less than 32 MB 

⚫ 0x06 FAT16, greater than 32 MB 

https://www.partitionwizard.com/help/partition-properties.html
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⚫ 0x0E FAT16 using LBA mode to access to FAT16 partition 

Usually GPT hard drive has EFI system partition or Microsoft reserved partition, which refers to 

the partition type ID. When there is a special need, users may want to change the partition type ID. 

MiniTool Partition Wizard provides users a feature to change type ID on GPT disk. 

29.2 How to Change Partition Type ID 

Change Partition Type ID is very simple. Only three steps are required to complete this job. The 

following is the MiniTool Partition Wizard tutorial. 

Step 1. Select or right-click the partition and click Change Partition Type ID from the action 

panel or pop-up menu. 

 

Step 2. Choose a partition type ID from the list or enter ID manually according to actual need. And 

then click Yes button to go back to the main interface. 
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Step 3: Click Apply to execute this change. 
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30. Explore Partition  

30.1 About Explore Partition 

Explore Partition feature ensures that it is the partition users want to modify. For 

example, when users are managing partitions under boot mode, it is difficult to 

identify each partition because drive letter can be disordered. 

Besides, it is convenient for you to explore partition at first and then manage it 

within the same utility even in Windows. So, how to explore partition? Please 

read this MiniTool Partition Wizard Tutorial. 

30.2 How to Explore Partition 

Step 1. Select the target partition, and then choose Explore Partition from action panel. 

 

Note: MiniTool Partition Wizard only supports the exploration of FAT12, FAT16, FAT32, and 

NTFS partitions. 

https://www.minitool.com/lib/drive-letter.html
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Step 2. This software lists all files in this partition with a tree structure. There you can view File 

Name, File Size, Creation Time and Modified Time altogether. 

 

31. Hide/Unhide Partition  

31.1 About Hide/Unhide Partition 

It is a common sense that lots of users are accustomed to store valuable photos, business 

documents and personal files to computer hard drives. In this case, many users don’t want others 

to access their confidential files without permission. 

At this time, they can choose to hide that partition, so that the files can never be seen by malicious 

people. Users themselves can’t see the hidden partition in the computer, either. So if they need to 

make the partition accessible to all, they should unhide partition. 

Common situations where users need to hide/unhide partition: 

⚫ If users have installed multiple operating systems on the same computer, they’d better 

hide the other system partitions for the sake of file integrity. 

⚫ Users might want to hide the disk partition which includes recovery tools or other kinds of 

significant files. 

https://www.minitool.com/lib/system-partition.html
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⚫ To manage or use files in a hidden partition, users need to unhide the partition at first. 

⚫ If users want to share the files in a hidden partition with families or friends, they should 

unhide it. 

31.2 How to Hide/Unhide Partition 

Lacking related experience and knowledge, ordinary users often don’t have a clear idea of how to 

hide/unhide partition. MiniTool Partition Wizard offers a good way to help them hide/unhide 

partition conveniently and safely. 

31.2.1 How to Hide Partition 

Step 1. Open the software and enter its main interface. Then, select the target partition and 

choose Hide Partition from the left action panel or right-click menu. 

 

Step 2. Then the target partition is shown without partition letter on the interface. Click Apply to 

save the change. 
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31.2.2 How to Unhide Partition 

Step 1. Select the target partition and choose Unhide Partition from the left action panel or 

right-click menu. 
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Step 2. There will be a pop-out window which allows users to set a new drive letter to the target 

partition. Choose a letter and click on OK to back to the main interface. 
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Step 3. Here, the target partition is shown with the specified drive letter. Then, click on Apply to 

save the change. 
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32. Partition Surface Test  

32.1 About Partition Surface Test 

Sometimes, users have difficulty in managing partitions (such as create partition, extend partition, 

shrink partition and move partition). For example, the partition management tool runs quite slow 

or even stops running at a time point. 

These might be caused by the bad sectors on partition. At this time, users need a partition surface 

test tool which can help confirm whether there are bad sectors on the target partition. 

MiniTool Partition Wizard is strongly suggested here since it can scan each partition sector status 

by reading data from the sector. After scanning, partition block without reading error will be 

marked with green color, and partition block with reading error will be marked with red. 

32.2 How to Perform Partition Surface Test 

Step 1. Click the target partition to be checked and select Surface Test from 

the Check Partition group OR from the Partition menu.  

https://www.minitool.com/lib/bad-sector.html
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Step 2. In the new window, click Start Now to begin partition surface test. Then, this software 

will show the result.  
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After viewing MiniTool Partition Wizard Tutorial above, users can easily make a 

partition surface test to check whether there are bad sectors on the partition.  

33. Partition Properties  

33.1 About Partition Properties 

 

Users can check detailed information of the partitions with Properties function. For 

the partitions recognized by Partition Wizard, this function will show partition 

properties including detailed file system parameters. 

Usage 

⚫ Used space 

⚫ Unused space 

⚫ Total space 

Partition Information 

⚫ Partition Type ID 

⚫ Partition ID (only for partitions on GPT disk) 

⚫ File System 

⚫ Serial number 

⚫ First Physical Sector 

⚫ Last Physical Sector 

⚫ Total Physical Sector 

File System Information 

⚫ Sector per Clutter 

⚫ Sector per File Record 

⚫ Sector per Index Record 

⚫ Logical Cluster Number of the $MFT 

⚫ Logical Cluster Number of $MFTMirr 

What's more, Partition Wizard will also provide a pie chart of the partitions so that users can view 
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the present space of the partitions conveniently and intuitively. 

33.1 How to View Partition Properties 

Step 1. To use this function, right-click the target partition, and then select Properties feature to 

view partition properties. 

 

Step 2. Then in Partition Info tab, users can view the detailed partition information. 
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34. Data Recovery 

34.1 About Data Recovery 

Data Recovery is designed to recover files from the logically damaged partition, formatted 

partition, and RAW partition as well as to recover files mistakenly deleted from internal or 

external hard drives. 

Besides, many computer users may have encountered partition loss due to some reasons like 

system update, hard drive failure, OS corruption, etc. And certainly, data in the partition is lost. 

Lost partition will be shown in the main interface of Data Recovery, and users can scan the lost 

partition to recover lost or deleted files after partition loss or deletion. 

34.2 How to Recover Lost Data from Hard Drive 

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. To recover files from hard drive, click Data Recovery on the top Tool Bar. 

Note: Only basic disk has Partition Type ID and Partition ID. For GPT basic disk, both are 

displayed. For MBR basic disk, only Partition Type ID can be viewed. 

Note: Data Recovery feature is only available in MiniTool Partition Wizard Pro Ultimate and 

above edition. For more information, you can check MiniTool Partition Wizard Edition 

Comparison. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3. After launching Data Recovery function, users will enter the following interface where all 

the detected disk partitions are arrayed by drive letters. 
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Here Data Recovery will list 5 parts, and every part is different from each other. 

⚫ Recovery Result: this section will show the last scanning result record and you can manually 

load scanning result to check recovered files directly. 

⚫ Logical Drive: this section will show all existing partitions on users’ disk, including 

removable devices like USB drive. For partitions that do not have drive letters, they are 

arranged at the end of the list. 

⚫ Lost Partition: this section will show all lost partitions detected by Data Recovery, and then 

users can retrieve data from lost partitions. 

⚫ Unallocated Space: this section will show all unallocated spaces on users’ computer. 

⚫ Hard Disk: this section will list all hard disks on the computer. Users can also select a hard 

disk to scan. 

Then, Users can select a partition and click Scan. Here I take partition G as an example. 
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Kindly reminder: 

If the target partition is not listed, please click the refresh icon on the top to refresh this interface. 

If users want to recover some specified file types on certain partitions, use Settings option near 

the Scan button to help. This way can save some scanning time. 
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Step 4. See! This software is scanning the selected partition. And it can find the lost or deleted 

files while scanning. If users have found crucial data, they can click icons in the red box to pause 

or stop the scan process for instant data recovery. 
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Step 5. After completing the scan, users need to find files they need. Then, check some items and 

click Save button. 

Note: Right-click a partition and choose Data Recovery from the pop-up Windows will get the 

following interface directly. 
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Besides, to quickly find needed files, MiniTool Partition Wziard's Data Recovery offers the 

following options to users, which can help to find needed files very quickly. 

Type 

In type section, all the founded files will be displayed by file type. Just unfold a file type and 

choose certain items of this type to recover. 

Tip: This software allows previewing a picture or .txt file which should be smaller than 20MB. 
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Show Lost Files 

This option helps users find the lost files quickly. Just click Show Lost Files button to make the 

software only show you the lost files. 
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Find 

This option allows users to input the specific file name so as to quickly find the needed file. Just 

click Find button, type the file name and click Find finally. For an exact search, users can 

check Match Case or Match Word. 

⚫ The Match Case option requires users to pay attention to the capital and small letter of file 

name. 

⚫ The Match Word option requires users to type the complete file name including file 

extension. 

⚫ If there is more than one file that matches the searching condition, after clicking Find button, 

users can click Find Next button to check whether it is the one you want. 
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Filter 

This Filter option enables users to search files by filename/extension, file size, creation or 

modification date. Besides, users can also choose to show deleted, lost or normal files according to 

their needs. Just click Filter button, and make some advanced settings in the pop-up window. 
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Step 6. Finally, choose a directory to save selected files. It is recommended to save the 

recovered files on another drive. Otherwise, the lost/deleted data could be overwritten. 
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Kindly reminder: 

If users don't want to perform the recovery operation right now or have some problems when 

using this software, Export Scan Result option helps them to export the scan result to avoid a 

new scan. Click this feature, add a file name for the .rss file and export it to a location. 
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Next time when users open Data Recovery, just use Load Manually feature on the main interface 

to upload the scan result directly so that they don’t need to rescan the drive for recovery. 
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Apart from that, Data Recovery will keep the last time scanning result. Click the partition you 

scanned last time in the Recovery Result section and then choose Load Result, users will get the 

last time scanning result. 
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35. Disk Benchmark 

35.1 About Disk Benchmark 

Benchmarking has been a popular way to test disk speed for years. It is the process of running 

software to measure the transfer speeds under various disk access scenarios like sequential and 

random, and showing the results in MBps that summarize the speed characteristics of a disk. 

What are sequential and random read/write? 

Sequential read/write is a disk access pattern whereby large contiguous blocks of data are read 

from OR written to adjacent locations on the surface of a storage device. Conversely, random 

read/write is another disk access pattern whereby data are read from OR written to nonadjacent 

locations on the surface of a storage device. 

There are multiple SSD benchmark tools available which can be easily obtained to run hard drive 

benchmark. And today, MiniTool Partition Wizard is the very choice as it allows users to quickly 

take the most common measurements on HDD/SSD with little configuration.  
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35.2 How to Perform SSD Benchmark Using MiniTool Partition 

Wizard 

Disk benchmark feature of MiniTool Partition Wizard is designed to measure storage 

performance using variable transfer sizes and test lengths for both sequential and random 

read/write speeds. Several options are available for users to customize the hard drive performance 

test: 

⚫ Transfer sizes from 1KB to 2048KB 

⚫ Transfer lengths from 100MB to 4096MB 

⚫ Supports a variety of queue depths (queue number) from 1 to 512 

⚫ Supports a variety of thread numbers from 1 to 64 

⚫ Allows continuous sequential & random read/write testing 

⚫ Non-destructive performance measurement on formatted drives 

⚫ Shows results with clear and intuitive graphics 

With this hard drive benchmark tool, users can test any manufacturer’ RAID controllers, storage 

controllers, hard drives and SSD drives. 

Step 1. Run MiniTool Partition Wizard to get the main interface. Then from the toolbar, 

select Disk Benchmark.   

Tip: Tests are likely to take a long time to complete especially when the transfer size has a 

large span. MiniTool Partition Wizard will create a temporary file during the testing process 

which will get deleted when finished. 
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Step 2. Now in the Disk Benchmark window, configure the following parameters before hitting 

the Start button.  

⚫ Select a Drive: select a partition to start the benchmarking. While Disk Benchmark is able to 

measure the performance of both basic disks and dynamic disks, users need to know that a 

drive letter is essential (click here to view the best way to add drive letter). 

⚫ Physical Disk: show users the disk module of the selected drive. 

⚫ Transfer Size: the size of data transmitted at one time which ranges from 1KB to 2048KB. 

⚫ Total Length: the total amount of data to be transferred which ranges from 100MB to 

4096MB. 

⚫ Queue Number: queue up a bunch of asynchronous read/writes in the drive, and the drive 

does them as quickly as it can. 

⚫ Tread Number: set up how many threads to be used to finish the disk speed test. 

⚫ Test Mode: choose a mode to test, which can be Sequential, Random, and Sequential & 

Random. 

⚫ Cool Down Time: set up the cool down time to reduce the hard drive temperature before it 

continues with the next test. 

https://www.partitionwizard.com/help/change-letter.html
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Step 3. Wait patiently until Disk Benchmark finishes the hard drive speed test and shows users a 

complete graphical result. 

Tip: For 4KiB read/write test (the speed at reading/writing small files of 4 KB in size), choose 

two 4KB in the Transfer Size interval. 
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35.3 What Kind of Performance Should Users Expect? 

While it is easy to obtain the hard drive performance numbers, users may find it hard to learn 

more. For instance, what is the standard read/write speed for today’s SSD? Does the drive 

tested hit the score? With those in mind, MiniTool goes one step further to help users understand 

their drive performance better. 

35.3.1 Average Read/Write Speed for SATA Solid State Drive 

(SSD) 

As users know, SSD enjoys fast read/write speed. But how fast indeed can it go? Usually, SSD 

connected with SATA interface brings 500MB/s around read speed. What’s more, if the SSD is 

equipped with PCIe, the transferring speed is more outstanding.  

Here MiniTool shows the performance of the most popular (SATA) SSDs on the market. These 

data are for reference only. Since test environment can vary, users may expect different 

benchmarking results even testing with the same storage device. 

Explanations for the following entries: 

⚫ Seq Q32T1: Sequential (Block Size=128KiB) Read/Write with 32 Queues & 1 Thread 

https://en.wikipedia.org/wiki/PCI_Express
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⚫ 4K Q8T8: Random 4KiB Read/Write with 8 Queues & Threads 

⚫ 4K Q32T1: Random 4KiB Read/Write with 32 Queues & 1 Thread 

⚫ 4K: Random 4KiB Read Write with single Queue & Thread 

⚫ Total Length: 1GB for all devices 

Samsung 860 Evo Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
563.501 495.867 

4KB 

Q8T8 
405.233 362.609 

4KB 

Q32T1 
390.353 362.32 

4KB 47.7528 139.121 

Toshiba TR200 Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
560.268 504.617 

4KB 

Q8T8 
275.237 229.539 

4KB 

Q32T1 
342.833 366.976 

4KB 26.641 88.713 
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Crucial MX500 Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
555.658 507.542 

4KB 

Q8T8 
404.746 365.86 

4KB 

Q32T1 
176.128 163.233 

4KB 25.917 62.285 

WD Blue 3D NAND Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
564.233 533.038 

4KB 

Q8T8 
393.42 347.369 

4KB 

Q32T1 
221.17 203.644 

4KB 36.5327 144.971 

SanDisk Ultra 3D Read (MB/S) Write (MB/S) 
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Seq 

Q32T1 
556.011 534.322 

4KB 

Q8T8 
399.526 349.126 

4KB 

Q32T1 
290.034 271.837 

4KB 41.125 100.424 

Kingston A400 Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
428.238 506.563 

4KB 

Q8T8 
337.743 352.52 

4KB 

Q32T1 
287.268 277.044 

4KB 30.453 96.652 

Gigabyte UD Pro Read (MB/S) Write (MB/S) 

Seq 

Q32T1 
564.651 525.247 
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4KB 

Q8T8 
329.906 306.728 

4KB 

Q32T1 
287.66 265.448 

4KB 35.022 116.946 

35.3.2 Possible Causes for Abnormal Testing Result 

If the hard disk speed test shows much different results from the above data, here are 2 possible 

causes: 

⚫ The Solid State Disk (SSD) is connected via USB interface which definitely affect the SSD 

speed test. If this is true, users are likely to see a 50 MB/s around speed. 

⚫ The Hard Disk Drive (HDD) is badly fragmented. Fragmentation causes the hard drive to 

perform extra work that affects disk performance. Defragmenting hard drive should help 

improve performance. 

36. Space Analyzer 

When a hard drive is running out of space, users may wonder which file is taking up too much 

space. Here is a simple way to find this out – using MiniTool Partition Wizard’s Space Analyzer 

function. 

36.1 About Space Analyzer 

Space Analyzer is a utility newly embedded in MiniTool Partition Wizard. This hard drive 

Tip: For overall responsiveness and most gaming applications, 4K is more user-focused in disk performance 

test. 

https://www.partitionwizard.com/partitionmanager/defrag-windows-7.html
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analyzer enables users to scan a hard drive and give users a better view of the hard drive space 

usage. Besides, this feature is useful for disk cleanup when hard drive is full and helps convert 

NTFS to FAT when receiving file is too large for the destination file system error. 

After Space Analyzer analyzes the hard drive and directories and lets users understand which files 

and folders are occupying more space on the drive, users can manually explore files and delete 

unnecessary files and applications in Space Analyzer. 

The hard drive space analyzer supports all kinds of hard drives like SSD, HDD, external hard 

drives and other removable devices like USB flash drive. Then how to use the disk space analyzer? 

This tutorial will show detailed steps with screenshots given. 

36.2 How to Use Space Analyzer? 

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. Select the Space Analyzer feature on the top toolbar to launch the disk usage analyzer. 

 

Step 3. Choose a partition to scan from the drop-down menu and click Scan. 

https://www.partitionwizard.com/partitionmagic/hard-drive-is-full.html
https://www.partitionwizard.com/convertpartition/file-is-too-large-for-destination-file-system.html
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Step 4. Wait for the completion of the scanning. And users can see the scanning partition’s Total 

Space, Space Used and Space Free on the top of the page. 

Depending on the number of files in the hard drive that should be analyzed, the disk usage 

analysis process may take from a couple of minutes to hours for files of different size and number. 
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Step 5. After the scanning is completed, space analyzer provides you with three ways to view disk 

space usage. 

Tree View: 

Tree View presents users a hierarchical view of files and folders in the hard drive that has been 

analyzed. Each folder can have a number of subfolders. On the Tree View tab, a folder can be 

expanded to several subfolders and collapsed to hide subitems. 

 

Users can expand these folders and right-click to open, explore, copy path, delete to recycle bin, 

delete permanently or check its property. Besides, copy a file or folder’s path and paste it to 

This PC can find the folder out with its specific location and get a view of files in this folder. 

Note: Files grayed out are hidden files, which are invisible in This PC. 
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Here you might have noticed that the interface is divided into to two parts, drag the column 

leftwards, you can see more detailed information. 

 

At this part, files are in a descending order according to their filename extension. And you can 

check which kind of files take too much space from the Size column. Double click them, you will 
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get into the interface of this kind of files. You can delete unnecessary one to free up some space. 
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File attributes are pieces of information relevant to every file and directory that includes additional 

data about the file itself or its contents. Attributes can be in files, directories, volumes and certain 

system objects. They are used by the operating system and software applications to define file 

system behavior. 

Under the Attributes column, you can see there are some upper case letters, which represents the 

file’s attribute. Here are some commonly seen file attributes. You can have a look. 

⚫ A: Archive 

⚫ C: Compressed 

⚫ D: Directory 

⚫ E: Encrypted 

⚫ H: Hidden 

⚫ I: Not Content Indexed 

⚫ L: Reparse Point 

⚫ N: Normal 

⚫ O: Offline 

⚫ P: Sparse (Pinned) 

⚫ R: Read-Only 

⚫ S: System 

⚫ T: Temporary 

File View: 

File View will display all the files in a descending order according to file size. On the File View 

tab, users can use File Search Filter to check a specific file’s size. With Match file name 

only option checked, users can input file name to find the file they want. And Match entire 

path option requires users to input the entire path correctly. 

Note: Here you can see that some files have different color and some may be grey out. That’s 

because they have different file attributes. 
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Folder View: 

Folder View will list all files in folders. On the Folder View tab, users can check Show all 

directories, which will list all folde rs and show which directory is taking too much space. 

 

And Show last level directories will only navigate folders to the last level and presents more 
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detailed information for each folder. 

 

37. Migrate OS to SSD/HD 

37.1 About Migrate OS to SSD/HD 

In today's era, computer hard drive is not only the medium to store and exchange data, it also 

provides an entertaining way. Users can download good music tracks and movies to the hard drive 

so as to listen to or watch them whenever they want. 

As the size of files stored on the hard drive is increasing, the running speed and responding speed 

of computer will be greatly affected. Meanwhile, the appearance of SSD offers users a wonderful 

experience in speed. So to replace the old hard drive with a new SSD or migrate OS to new SSD 

becomes the first choice to improve computer performance and speed. 

In addition, some large-scale online games are required to download to hard drive. This can easily 

make the old hard drive run out of space in a short time. The most direct and effective way to deal 

with this situation is also to replace the old hard drive with a new larger SSD or HD. 

In both cases, if users don’t want to reinstall Windows and programs or don’t want to lose 

anything, we highly suggest using Migrate OS to SSD/HD feature of MiniTool Partition Wizard 

to do this, which is an easy and safe process. 

Below is a detailed MiniTool Partition Wizard tutorial on OS migration. 

Note: The migration process of Partition Wizard will destroy all data in users' target disk, so 

users would better transfer data to another device or make a backup in advance. Yet, it doesn’t 

have any effect on the data in the original disk. 

https://www.minitool.com/lib/ssd.html
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37.2 How to Migrate OS to SSD/HD 

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. Click on Migrate OS to SSD/HD in the toolbar. 

 

Step 3. Choose a right method to migrate system disk and click Next. 

Option A. To Replace the System Disk 
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Firstly, please select the target disk to migrate system disk to and click Next. 
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Then, choose a copy option. Alternatively, users can manually edit partition size by inputting exact 

partition size in MB, GB, or TB. 

 

Tricks: 

⚫ Align partitions to 1MB could help improve performance for SSD and advanced format 

disks, so please keep it checked if users are using such devices. 

⚫ Checking Use GUID Partition Table for the target disk makes it possible to use all space 

of hard disk larger than 2TB, but UEFI boot should be enabled in BIOS. 

⚫ MiniTool Partition Wizard Free Edition doesn’t support migrating OS on MBR disk using 

GUID Partition table for the target disk. 

⚫ If users want to migrate Windows which is installed on a GPT disk, they will not see the 

option Use GUID Partition Table for the target disk. 

Next, read a popup note and click Finish to continue. 

https://www.minitool.com/lib/mbr.html
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At last, click Apply button to execute pending operations and tap Yes in pop-up prompt window 

to allow changes. 
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Option B. To Migrate Windows Only 

 

Here, users also need to select the target disk to transfer Windows 10 to and click Next. 
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Then, select a copy option and click Next. 

 

Next, read the boot note and click Finish. 
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At last, click Apply button in the toolbar to execute pending operations and tap Yes in the pop-up 

prompt window to allow changes. 

 

38. Partition Recovery 

38.1 About Partition Recovery 

Hard disk partitions may get lost or disappear due to one of these factors: mistaken 

deletion, virus attack, wrong ghost, sudden power outage, incorrect partitioning, and 

so on. In these cases, Partition Recovery is quite a good solution to dealing with 

partition loss, recovering lost partitions and data altogether. 

 MiniTool Partition Wizard is a partition recovery software that can recover lost/deleted partitions 

as long as new partition hasn’t been created. The tutorial below shows detailed steps on how to 

recover lost/deleted partitions easily. 

https://www.minitool.com/lib/hard-disk-partition.html
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38.2 How to Recover Lost Partition  

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. Right-click the disk where partition loss appears and directly choose Partition 

Recovery from the pop-up window. 

 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3. Choose a scanning range from Full Disk, Unallocated Space, and Specified Range, and 

then click on Next button. 

 

Step 4. Set a scanning method to scan the specified range and click Next. 

Note: If it is a GPT disk that encounters partition loss, and it turns to an MBR disk after 

partition loss, please convert MBR disk to GPT first, and then employ the Partition Recovery 

feature. 
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Step 5. Check all needed partitions, including existing partitions and deleted/lost 

partitions, and then click Finish button.  
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Please make sure all needed partitions have been checked. Otherwise, users will receive the 

following warning message and some useful partitions will be deleted. 

 

Step 6. Assign a letter for the recovered partition(s) using Change Drive Letter feature if users 

want to see it in Windows Explorer. 

Note: The existing partitions will be checked by default, so users just need to manually check 

Lost/Deleted partition. 

https://www.partitionwizard.com/help/change-letter.html
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Step 7. Then click Apply button on the top to perform partition recovery. 
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If Partition Recovery doesn't work, users can try the Data Recovery function in MiniTool 

Partition Wizard. Here are their differences. 

     Partition Recovery      Data Recovery 

⚫ Rebuild partition table. 

⚫ Recover lost/deleted partition as 

well as data in it. 

⚫ Allow previewing data structure. 

⚫ All data will be recovered. 

⚫ Recover lost/deleted data from Recycle Bin/lost 

partition/damaged partition and CD/DVDs. 

⚫ Allow previewing data structure as well as some types of 

files. 

⚫ Allow scanning specified file types and only recover 

data users selected. 

39. Copy Disk 

39.1 Copy Disk Wizard 

Copy Partition Wizard feature copies all data from one partition to another without any data loss 

with ease. Compared with copying files directly, to copy partition helps users save much time. 

Therefore, when users plan to backup files saved in one partition, try copying the whole partition. 

When MiniTool Partition Wizard is copying partition, data protection solutions such as power-off 

protection is activated automatically. Don’t worry about data security even if power outage 

emerges without redundant power supply. 

39.2 How to Copy Partition 

Step 1. Run MiniTool Partition Wizard to get its main interface, directly choose the Copy Disk 

Wizard from the toolbar.  
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Step 2. Click Next to continue. 
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Step 3. Select the disk users would like to copy and click Next.  

 

Step 4. Choose a target disk where the copy will be stored and click Next to continue. Then 

click Yes to continue. 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 
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Step 5. Choose a copy method and click Next. 

 

Attention: 

1. For SSD users, it is highly recommended to Align partitions to 1MB option, which can 

improve disk performance. 

2. If users want to copy disk to GPT disk, Use GUID Partition Table for the target disk option 

is limited in Free Edition of MiniTool Partition Wizard, but the Professional Edition or an 

advanced one is available. 

Step 6. Read the note carefully which shows how to boot from the target disk, and click Finish to 

go back to the main interface. 

Note: Please backup important data on the target disk in advance because all its data will be 

deleted during copy operations. 
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Step 7. Click Apply to execute all changes. 

 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

40. Rebuild MBR  

40.1 About Rebuild MBR 

MBR (Master Boot Record) is a special type of loader code at the very beginning of computers' 

hard disk. It contains an operating system bootloader and the storage device’s partition table. 

When DOS reads hard disk, MBR will help to check whether the partition is legal and locate the 

partition boot information. 

And, the loader code is variable. Thus, users can boot MBR from multiple operating systems. It 

can be found in FDISK program. MBR will pass the control over to the certain operating system 

which has been registered in the partition table. 

However, MBR could be damaged due to various attack, mistaken operation, or sudden power 

failure. Once MBR is damaged, users may encounter boot problems such as MBR error 3 and see 

Windows black screen.  

Rebuild MBR of MiniTool Partition Wizard helps rebuild MBR in quite simple operations even if 

Windows cannot boot. That is because this partitioning program offers a bootable disc to boot 

computer without Windows. 

40.2 How to Rebuild MBR 

Since Windows cannot boot, users can use the Bootable Media Builder feature to create bootable 

CD/DVD/USB flash drive or build an ISO image of a bootable disc. After that, use the bootable 

disk to start computer to get the following window. 

Kindly reminder: the free edition of MiniTool Partition Wizard doesn’t provide Bootable Media 

Builder. 

Step 1. Please choose the first option Partition Wizard to enter the main interface of MiniTool 

Partition Wizard. 

https://www.minitool.com/lib/mbr.html
https://www.minitool.com/lib/partition-table.html
https://www.partitionwizard.com/partitionmagic/partition-magic-boot-cd.html
https://www.partitionwizard.com/partitionmagic/partition-magic-boot-cd.html
https://www.minitool.com/boot-from-created-recovery-cd.html
https://www.minitool.com/boot-from-created-recovery-cd.html


 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

Step 2. Launch MiniTool Partition Wizard. 

 

Step 3. Select the system disk which is suffering MBR damage and click Rebuild MBR from the 
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left panel. 

 

Step 4. At last, click Apply button to apply the change. 
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And after application, users need to quit from MiniTool Partition Wizard bootable disc and boot 

from the local hard drive 

41. Delete All Partitions  

41.1 About Delete All Partitions 

Delete All Partitions feature provided by MiniTool Partition Wizard can remove multiple 

partitions off at a time. If users have got multiple partitions to delete, Delete All Partitions feature 

is labor-saving. 

41.2 How to Delete All Partitions 

Users can follow the MiniTool Partition Wizard tutorial on how to delete all partitions below: 

Step 1. Select a way to activate certain feature according to preference: 

⚫ Strategy A: Choose the disk whose partitions need to be deleted and click Delete All 

Note: Do not operate disk containing boot partition, otherwise boot failure may appear. 
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Partitions from left action panel. 

⚫ Strategy B: Choose target disk and click Disk in menu. After that, click Delete All 

Partitions from dropdown menu. 

⚫ Strategy C: Right click the target disk and then click Delete All Partitions from pop-up 

context menu. 

 

Step 2. In this interface, click Yes button to let the software execute partition deleting command. 
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Step 3. At last, click Apply to execute pending operations. 
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42. Align All Partitions 

42.1 About Align All Partitions 

Unlike Align Partition which just aligns a single partition, Align All Partitions feature aligns all 

hard drive partitions on an SSD disk or advanced format HD in one step. If users take one of the 

following operations, it is very necessary to align all partitions: 

⚫ Copy an advanced format HD or SSD to another advanced format HD or SSD. 

⚫ Change size or move location of multiple partitions. 

42.2 How to Align All Partitions 

Step 1. Run MiniTool Partition Wizard to get the main interface. 

Step 2. Select the disk which needs aligning and choose Align All Partitions feature from the left 

action panel or from the right-click menu. 

 

Step 3. If Partition Wizard detects misaligned partition(s), it will show how many partitions to 

align in total. Just confirm the operation by clicking OK button. 

https://www.minitool.com/lib/advanced-format.html
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Step 4. Click on Apply button on the top left corner to perform all operations. 
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43. Wipe Disk 

43.1 About Wipe Disk 

Wipe Disk can destroy all information in selected disks safely and permanently. This function can 

ensure the security of users’ privacy as well as unwanted data, and prevent someone from 

recovering those data. 

Once the Wipe Disk operation is carried out by MiniTool Partition Wizard, the data will not be 

recovered by any data recovery software. If users employ the method of DoD 5220.28-STD, the 

data can’t be recovered by any data recovery solutions. 

43.2 How to Wipe Disk 

Step 1. Launch the program to enter its main interface shown below. Then select the disk which 

needs to be wiped and choose Wipe Disk from the left action panel or from the right-click menu. 

Tip: If all partitions on the disk are already aligned, users will receive the following 

information. Just click OK to end the operation. 

https://www.minitool.com/data-recovery-software/
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Step 2. Choose one of the five wiping methods listed on the pop-out window and click OK. 

Different wiping methods cost different time and bring different security. To be specific, the more 

time it costs, the higher security you enjoy. 
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Step 3. Now users can see the selected disk becomes unallocated, which means it will be wiped 

thoroughly. At this time, please click Apply button on the top to perform all changes. 

44. Disk Surface Test  

44.1 About Disk Surface Test 

Sometimes, when performing some specific operations or open some files, the computer is 

significantly running slow or the disk is ticking. Such problems might occur when there are 

some bad sectors on the hard disk. Nevertheless, how to confirm whether there is bad sector? 

MiniTool Partition Wizard can help users in this case since it provides Disk Surface Test function 

to scan each sector status by reading data from the sector. After scanning, disk block without 

reading error will be marked with green color, and disk block with reading error will be marked 

with red. 

If there are some bad sectors, please first transfer all data on this disk out and then use specific 

software to shield bad tracks. After shielding, if there are still red disk blocks, users have to turn to 

professionals to repair the physical bad sectors. 

44.2 How to Make Disk Surface Test 

https://www.minitool.com/lib/bad-sector.html
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Step 1. Click the target disk to select Surface Test from the left action panel, or right-click the 

target disk at first, and then select Surface Test from the drop-down menu. 

 

Step 2. Click Start Now button in the new window to start disk surface test. Then, 

this software will automatically test the disk surface and show the result.  
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45. Disk Properties  

45.1 About Disk Properties 

Disk Properties reveals the physical information of the chosen disk. And MiniTool Partition 

Wizard shows these items in Disk Properties: 

⚫ Device Name 

⚫ Cylinder 

⚫ Heads 

⚫ Sectors Per Track 

⚫ Bytes Per Sector 

⚫ Physical Sectors 

⚫ Total Size 

⚫ MBR Signature (for MBR disk)/GPT GUID (for GPT disk) 

45.2 How to View Disk Properties 

Step 1. Select a disk, then click Disk Properties from the action panel or directly right-click the 

disk and choose Properties from the context menu. 
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Step 2. Then users are able to view the detailed properties of the selected disk. 
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46. Create Volume   

46.1 About Create Volume 

With the help of Create Volume feature offered by MiniTool Partition Wizard, users 

can create dynamic disk volumes including Simple Volume, Spanned Volume, 

Striped Volume (Raid 0), Mirrored Volume (Raid 1) and Raid-5 Volume. Different 

volumes need different preconditions. 

⚫ Simple Volume: A simple volume is a dynamic volume that is made up of disk space from a 

single dynamic disk. 

⚫ Spanned Volume: A spanned volume is a dynamic volume consisting of disk space on more 

than one physical disk. At least two dynamic disks are required in addition to the startup disk 

to create a spanned volume. 

⚫ Striped Volume (Raid 0): A striped volume is a dynamic volume that stores data in stripes 

on two or more physical disks. Striped volumes offer the best performance of all the volumes 

that are available in Windows, but they do not provide fault tolerance. 

⚫ Mirrored Volume (Raid 1): A mirrored volume provides an identical twin of the selected 

volume. All data written to the mirrored volume is written to both volumes, which results in 

disk capacity of only fifty percent. 

⚫ Raid-5 Volume: Three hard drives, which can be IDE, SCSI or mixed structure, are entailed. 

All disks relevant to RAID-5 volume must be dynamic disks and operating system boot files 

and system files must be stored on another volume. 

46.2 How to Create Volume 

To create dynamic volume, view the MiniTool Partition Wizard tutorial below:  

Step 1. Select the segment of free space in dynamic disk and click Create Volume from the left 

action panel or select Create Volume from right-click menu.  

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View 0 to know 

more. 

https://www.minitool.com/lib/simple-volume.html
https://www.minitool.com/lib/spanned-volume.html
https://www.minitool.com/lib/striped-volume.html
https://www.minitool.com/lib/mirrored-volume.html
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Step 2. Choose the type of volume to be created in the popup window. The powerful partition 

manager can list out all supported types according to the practical situation (those that do not meet 

the requirement will turn grey). Select the available one and click Next button to enter the 

following interface.  
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Step 3. Select the destination disk where volume is to be created by only choosing the 

corresponding disk and then clicking Add option to add this disk to the right box. After that, 

click Next button to continue:  
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Step 4. Set relevant parameters including Volume Label, File System, Driver Letter, Cluster Size 

and Volume Size/Volume Location for the newly created volume and then click Finish button to 

return to the main interface of the software.  

https://www.minitool.com/lib/cluster.html


 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

Step 5. Then a new volume appears in the chosen dynamic disk. To validate this operation, please 

click Apply button in the upper left corner.  
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47. Delete Volume  

47.1 About Delete Volume 

If a dynamic volume is no longer in need, users can make use of Delete Volume feature to acquire 

more unallocated space by removing the volume. Users can follow the MiniTool Partition Wizard 

tutorial below to remove the target volume. 

 

47.2 How to Delete Volume 

Warning: All data in the selected volume (including all volumes slices) will be deleted when 

deleting a volume. Thus, be sure it is necessary to perform volume deletion. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 1. Launch this software to enter the following main interface. Then select the volume which 

needs to be deleted and choose Delete Volume from the left action panel or right-click menu. 

 

Step 2. Back to the main interface of the software, users can find that the selected volume has been 

removed from the dynamic disk. However, this is just a preview effect, users still need to 

click Apply button to finish the whole operation. 
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Please note that when managing dynamic disk and volume, MiniTool Partition Wizard always 

requires a reboot for data safety considerations. Please do as prompted. 
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48. Format Volume  

48.1 About Format Volume 

Format Volume feature helps format volumes with excessively redundant data or which are 

infected with rampant computer viruses. It can reset parameters including partition table, file 

system and cluster size for chosen volume. The following is the MiniTool Partition Wizard tutorial 

to format volume.  

48.2 How to Format Volume 

Step 1. After running MiniTool Partition Wizard, users will get the following main interface. Then 

choose the volume which needs to be formatted and click Format Volume feature from the left 

action panel or the right-click menu. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/lib/cluster.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 2. Now set Volume Label, File System, and Cluster Size for the target volume, and then 

click OK to go back to the main interface.  
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Step 3. Please click Apply button to execute the change. 
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If MiniTool Partition Wizard asks for a restart, please do as prompted. 

 

49. Wipe Volume  

49.1 About Wipe Volume 

If the data in a dynamic volume are not useful anymore, users can wipe it to get free space for new 

data. Wipe Volume function of MiniTool Partition Wizard helps to clear away data completely, so 

malicious recovery of privacy can be prevented.  

49.2 How to Wipe Volume 

If you don’t know how to wipe volume easily in MiniTool Partition Wizard, please keep on 

reading the following MiniTool Partition Wizard tutorial. 

Step 1. Select the volume that needs to be wiped on the disk map area of the software 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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interface. And then, choose Wipe Volume function from left panel OR choose it from the 

drop-down list of Dynamic Disk menu. 

 

Step 2. Choose a wiping method according to actual needs (the slowest one brings the best wiping 

effect). Then, click OK to end this step. 

⚫ Fill Sectors with Zero - Quick 

⚫ Fill Sectors with One - Quick 

⚫ Fill Sectors with Zero & One (Fill sectors with 0 then fill sectors with 1) - Slow 

⚫ DoD 5220.22-M (Fill sectors with DoD calculation for 3 times) - Very Slow 

⚫ DoD 5220.28-STD (Fill sectors with DoD calculation for 7 times) - Very Slow 
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Step 3. Click Apply in the toolbar to execute changes. Note that MiniTool Partition Wizard needs 

a restart to finish the operation for data security consideration. 
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Step 4. Please wait patiently until MiniTool Partition Wizard finishes. 
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50. Move/Resize Volume 

50.1 About Move/Resize Volume 

Move/Resize Volume feature in MiniTool Partition Wizard is much useful for you to change 

volume size on dynamic disk. With this function you can complete the following 3 operations: 

⚫ Shrink dynamic volumes including simple volume, mirrored volume, striped volume, 

spanned volume and RAID 5 volume to release unallocated space so as to create new 

volumes or extend another volume. 

⚫ Extend a mirrored volume, spanned volume, striped volume, or RAID 5 volume to 

unallocated space to enlarge volume size (note that Disk Management can only extend simple 

volume and spanned volume.) 

⚫ Move unallocated space to make it adjacent to the volume to be extended. 

50.2 How to Move/Resize Dynamic Volume 

Step 1. Run MiniTool Partition Wizard to get the main interface. Then, select the volume that 

needs to change location/volume size and choose Move/Resize Volume from the left action panel 

or from right-click menu.  

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/lib/mirrored-volume.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 2. To shrink a volume, just drag the border of the rectangle bar leftwards. To enlarge a 

volume, drag the handle rightwards. Alternatively, users can type exact volume size in MB, GB, or 

TB to edit volume size. 
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To move volume location, please drag the whole handle or manually define unallocated space in 

MB, GB, or TB before or after the volume. After getting needed volume size and location, users 

need to click OK to continue. 
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Step 3. Click Apply button at the top to perform changes.  
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51. Copy Volume  

51.1 About Copy Volume 

Data saved in dynamic volumes are not absolutely safe. For example, it may get lost due to 

mistaken deletion/formatting, virus attack, and hardware damage. Thus, it is very necessary 

to make a backup for important files. 

Nevertheless, copying files one by one will cost much time especially when there are so many 

files to backup. Fortunately, Copy Volume feature in MiniTool Partition Wizard can clone the 

entire dynamic volume effectively, saving a lot of time. And the copy can be used directly as the 

source. 

51.2 How to Copy Volume 

Step 1. Launch MiniTool Partition Wizard to get its main interface. Then, select the volume which 

needs copying and click Copy Volume feature from the left pane or from right-click menu. 

Tip: Most operations on dynamic disk will require a reboot, and users are expected to do as 

prompted. Then, MiniTool Partition Wizard will perform all changes in boot mode, which is 

much safer. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/backup/system-backup.html
https://www.minitool.com/lib/clone.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 2. Select a volume on dynamic disk or unallocated space on basic disk as the target location 

to save the copy of the source volume and click Next. 
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Step 3. Resize volume by changing the length of volume handle and move volume location by 

changing the position of the entire handle. Alternatively, users can type exact volume size in MB. 

Then, click Finish button. 

Tip: If the selected target location is a dynamic volume, users will receive the following 

warning message. Please click Yes to continue. 
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Step 4: Click Apply button to apply all changes.  

 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

52. Change Volume Cluster Size  

52.1 About Change Volume Cluster Size 

As is known to all, cluster is the smallest unit to save and manage files on disk in Windows 

operating systems. 

One cluster can only hold 1 file even if it is only 1 byte. The volume used for saving 

small files should be configured with small clusters, which can improve disk space 

use ratio. The volume used for saving large files should be appointed with large 

clusters, which can optimize data read-write speed largely. 

Well then, how to change cluster size of a certain volume reasonably? Change Volume Cluster 

Size feature of MiniTool Partition Wizard can help complete this operation in simple operations 

and without data loss. 

52.2 How to Change Volume Cluster Size 

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. Select or right-click the volume whose cluster size needs changing and choose Change 

Volume Cluster Size from the left panel or from right-click menu. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/lib/cluster.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3.Choose a reasonable cluster size from the drop-down list and click Yes to confirm the 

operation. 
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Step 4. Click Apply button on the toolbar to apply this change.  
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53. Change Volume Letter  

53.1 About Change Volume Letter 

Volume letter is the symbol of disk storage device. It is identified by one of the 26 English letters 

plus a colon. Due to historical reason, early PC usually has two floppy drivers. Therefore, the two 

volume letters A: and B: are used to stand for floppy disk drivers while hard disk volume letters 

start from C: to Z: 

Dynamic disk also has volume letters and each volume has only one letter. Users can change 

volume letter as they want. 

53.2 How to Change Volume Letter 

Step 1. Launch MiniTool Partition Wizard to get its main interface. 

Step 2. Click the target volume, and select the Change Volume Letter from the action panel OR 

select this feature from the context menu. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

Warning: Be careful when changing system volume letter for doing this on system partition 

may cause the computer unbootable. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3. Select a new drive letter and click OK button to go back to the main interface. It is worth 

mentioning that if None is selected, the target partition will disappear from File Explorer. 
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Step 4. Finally, click Apply to bring this change into effect. 
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54. Change Volume Label  

54.1 About Change Volume Label 

By default, disk partitions are displayed as Local Disk C: Local Disk D: etc. At this moment, disk 

partitions have no label. But users can label every partition to make them easy to distinguish, such 

as labeling partition C: as System C: 

The function Change Volume Label of MiniTool Partition Wizard gives each volume a unique 

label to facilitate management and memorizing. 

54.2 How to Change Volume Label 

Step 1. Select the target volume and click Change Volume Label from the action panel OR right 

click the target volume to select this feature.  

 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/lib/disk-partition.html
https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 2. Next, input new volume label and click OK button to go back to the main interface. 

 

Step 3. Finally, click Apply to execute the change to computer. 
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55.Check Volume File System  

55.1 About Check Volume File System 

Check Volume File System feature in MiniTool Partition Wizard is used to verify the 

logical integrity of the volume file system. To know the details of a volume, users can 

use this function to check and fix detected errors when there is a need. 

55.2 How to Check Volume File System 

Step 1. Run MiniTool Partition Wizard, right-click the target volume (for NTFS volume only) and 

then select Check File System feature from the pop-up menu. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.minitool.com/partition-manager/partition-software-comparison.html
https://www.minitool.com/partition-manager/partition-software-comparison.html


 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

Step 2. You can select a mode Check only or Check & fix detected errors, and then click Start. 
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Step 3. After finishing the check, click Cancel to go back to the main interface. 

55. Explore Volume  

56.1 About Explore Volume 

Explore Volume is a simple function that enables users to view the content of a volume. With 

MiniTool Partition Wizard, it is easy to know the file name, file size, file creation time and 

modified time in the volume even in Windows PE. 

56.2 How to Explore Volume 

Step 1. Right-click the target volume, and choose the Explore Volume from the context menu OR 

from the left action panel. 

 

Step 2. Volume explorer will display the file name, file size, creation time and modified time as a 

Note: This function is only available with the paid edition (view Edition Comparison) and only 

supports the exploration of FAT and NTFS file systems. 

https://www.partitionwizard.com/comparison.html
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tree view. 

 

56. Volume Properties  

57.1 About Volume Properties 

Volume Properties feature of MiniTool Partition Wizard makes it easy to check detailed 

information of dynamic volumes. Specifically. this feature shows users the followings: 

Usage 

⚫ Used Space 

⚫ Unused Space 

⚫ Total Space 

File System Information 

⚫ Sectors per Cluster 

⚫ Sectors per File Record 

⚫ Sectors per Index Record 
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⚫ Logical Cluster Number of the $MFT 

⚫ Logical Cluster Number of $MFTMirr 

57.2 How to View Volume Properties 

Step 1. To use this function, users need to select the target volume at first, and click Volume 

Properties from the left action panel. 

 

Step 2. After that, users will see the following interface which shows the volume information. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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57. Convert Dynamic Disk to Basic 

58.1 About Convert Dynamic Disk to Basic Disk 

Basic disk and dynamic disk are two basic hard disk configuration types in Windows System. The 

former one is more popular than the latter one and it can be found in most PCs. The management 

of basic disk is indeed much easier than that of dynamic disk, so basic disk is often more 

suitable for ordinary computer users. 

But for advanced users and IT administrators, if they would like to improve the performance of 

computer with more than one hard disk, they’d better choose dynamic disk. 

Dynamic disk is very different from basic disk. Several independent dynamic disks can join 

together to form a Spanned Volume in some versions of Windows. Data can be saved to different 

hard disks to form Striped Volume. Simple volume, mirrored volume, and RAID-5 volume can 

also be seen in a dynamic disk. 

In this way, the performance of computer will be greatly improved. However, to simplify the 

management of disk, ordinary users hope to convert dynamic disk to basic disk safely sometimes. 

https://www.minitool.com/lib/dynamic-disk.html
https://www.minitool.com/lib/spanned-volume.html
https://www.minitool.com/lib/striped-volume.html
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58.2 How to Convert Dynamic Disk to Basic Disk 

The steps to convert a dynamic disk to basic disk are very easy in MiniTool Partition Wizard. 

Before starting to convert, users need to know two things. 

⚫ This dynamic disk convert function is available in all editions except for the free edition. 

⚫ This software can only help to convert the dynamic disk containing simple volume and 

mirrored volume. 

The following MiniTool Partition Wizard tutorial will tell users how to convert dynamic disk to 

basic disk. Please read it carefully. 

Step 1. Choose the dynamic disk or partition which needs to be converted to basic from the Disk 

Map or Disk/Partition/Volume List area. 

Step 2. Choose Convert Dynamic Disk to Basic function from the left action panel. 

 

Step 3. Click Apply in the upper left to confirm executing pending operations. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 4. Tap Yes to carry out dynamic disk conversion pending operations.  

 

Step 5. Click OK when the disk conversion is completed automatically by software or 

click Restart Now sometimes when the dynamic disk users want to convert is in use.  
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58. Convert MBR Disk to GPT Disk 

59.1 About Convert MBR Disk to GPT Disk 

Master Boot Record (MBR) and GUID Partitioning Table (GPT) are two partition 

styles. Even though they achieve the mutual goal of separating the information for the 

operating system, they are very different from one another. 

These are 2 main differences between MBR disk and GPT disk: 

⚫ Number of partitions: an MBR disk supports at most four primary partitions or three primary 

partitions and one extended partition while a GPT disk can support up to 128 partitions in 

Windows. 

⚫ Size of partition: the size of a single partition in MBR disk can only reach 2 TB while the 

largest partition supported by GPT disk is 18 EB. 

But these aren’t the only reasons why so many users wish to convert from MBR disk to GPT disk. 

Note: Many other outstanding features can be found in GPT disk. For more information, please 

read this post MBR VS GPT ( Focus on Difference and How to Convert Safely). 

https://www.minitool.com/lib/mbr-master-boot-record.html
https://www.minitool.com/lib/gpt.html
https://www.partitionwizard.com/partitionmagic/mbr-vs-gpt.html
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One of the other amazing features the GPT disk also offers is the ability to store multiple copies 

of the data within the operating system. 

If the data is overwritten or corrupted, the GPT disk can recover the data, so the OS will function 

again. In contrast, the MBR disk does not have this feature and thus unable to easily recover 

corrupt or overwritten data. 

This explains why a growing number of users would like to convert MBR disk to GPT disk as 

soon as possible. But how to convert MBR disk to GPT disk without data loss? We suggest 

using MiniTool Partition Wizard Free Edition. 

59.2 How to Convert MBR Disk to GPT Disk 

Importance: 

If users are dealing with the system disk, do the followings in advance in case of any accidents 

after the conversion. 

1. Create a bootable media of MiniTool Partition Wizard. 

2. Create a system image or back up the whole system disk. 

If there are multiple operating systems, please confirm which operating system needs booting 

from GPT disk, and then boot from it to do the conversion. MiniTool Partition Wizard is not 

responsible for the rest operating systems not booting after the conversion. Do it at your own risk. 

The downloading and installation process of MiniTool Partition Wizard is easy to finish, even for 

inexperienced users. Now, let’s see how to do: 

Step 1. Choose the MBR disk that users want to convert. 

Step 2. Select Convert MBR Disk to GPT Disk function through following three ways. 

⚫ Click it under the Convert Disk list. 

⚫ Choose it from the drop-down list of Disk menu at the top. 

⚫ Right-click the target disk and choose it from the pop-up list. 

Note: The Free Edition can only convert a data disk to GPT. If users want to convert a system 

disk to GPT, they need to upgrade to an advanced edition. 

Note: MiniTool Partition Wizard can help users convert an MBR disk containing Windows to 

GPT. But if users want to boot from the GPT disk successfully, UEFI mode should be 

supported and enabled. 

https://www.partitionwizard.com/partitionmagic/partition-magic-boot-cd.html
https://www.partitionwizard.com/help/copy-disk.html
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Step 3. Click on Apply button in order to carry out pending operations. 
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Step 4. Choose Yes in the pop-up prompt window to start converting a disk from MBR to GPT. 

 

Step 5. Click OK button at the end of conversion to end the process. 
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59. Convert GPT Disk to MBR Disk 

60.1 About Convert GPT Disk to MBR Disk 

GPT, short for GUID Partition Table, is actually a standard BIOS partition table on a 

physical hard disk. Believe it or not, GPT is much better than MBR in many aspects. 

For instance, GPT disk supports at most 128 partitions in Windows while MBR disk 

supports only 4 primary partitions (or 3 primary partitions and 1 extended partition). 

No wonder so many users become fans of GPT disk. But why there are still some users who want 

to convert GPT disk to MBR Disk? 

Though GPT disk is more advanced when compared to MBR disk, users still need an MBR disk 

sometimes. 

For instance, if users are using a very old operating system like Windows 2000 Server, a GPT disk 

is not suitable. Even if users employ a GPT disk in Windows 2000 Server, they can't install the 

operating system to it because the booting from GPT disk is forbidden in such system. All in all, 

there are still some situations where users need to convert GPT disk to MBR disk. 

https://www.minitool.com/lib/gpt.html
https://www.minitool.com/lib/mbr.html
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60.2 How to Convert GPT Disk to MBR Disk 

Important: 

It is not recommended to convert system disk from GPT to MBR using MiniTool Partition Wizard. 

Proceed at your own risk! For the data drive, do the followings in advance in case of any accidents 

after the conversion. 

1. Create a bootable media of MiniTool Partition Wizard. 

2. Create a system image or back up the whole system disk. 

For the vast majority of computer users, how to convert GPT disk to MBR disk is a tough task 

since they are inexperienced in managing the disk. Because of that, we'd like to introduce an 

amazing tool – MiniTool Partition Wizard here; it allows users to finish GPT to MBR 

conversion without damaging data. 

Step 1. Run MiniTool Partition Wizard and choose the GPT disk on which conversion needs to be 

performed. 

Step 2. Choose Convert GPT Disk to MBR Disk function through the following 3 ways. 

⚫ Click Convert GPT Disk to MBR Disk under the Convert Disk list on the left side. 

⚫ Right click on target GPT disk and choose Convert GPT Disk to MBR Disk from the 

pop-up menu. 

⚫ Click Disk in the menu bar and choose Convert GPT Disk to MBR Disk. 

https://www.minitool.com/create-a-bootable-recovery-usb-disk.html
https://www.partitionwizard.com/help/copy-disk.html
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Step 3. Click on Apply button in the toolbar (at this time, users can see pending operations at the 

bottom of the left action panel). 
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Step 4. Tap Yes button to confirm conversion. 
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Step 5. Wait for the completion of disk conversion. Then click OK button finally. 

 

60. Convert FAT to NTFS  

61.1 About Convert FAT to NTFS 

It is obvious that NTFS beats FAT in many aspects. If users' flash drive, external hard disk 

partition or internal hard disk partition is formatted with FAT file system, they may want 

to convert FAT to NTFS to achieve the following purposes: 

⚫ Handle large files (over 4GB). 

⚫ Get better stability, higher security and lesser defragmentation time. 

But it is a pity that most of the users don't have a clear idea of how to convert FAT to NTFS. In 

view of this, we decide to provide users with an excellent tool – MiniTool Partition Wizard. The 

corresponding MiniTool Partition Wizard tutorial will be given below. 

61.2 How to Convert FAT to NTFS 

The MiniTool Partition Wizard is equipped with high security, so users can carry out all operations 

https://www.minitool.com/lib/file-system.html
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in this tool safely. That is to say, it can help users convert FAT to NTFS without causing any 

data loss. 

Follow this MiniTool Partition Wizard tutorial to execute FAT conversion. 

Step 1. Choose the FAT partition and select Convert FAT to NTFS from left Change 

Partition list or from right-click menu (which will emerge after right clicking on target FAT 

partition). 

 

Step 2. Click Start button at the bottom of the pop-up window to get FAT to NTFS conversion 

started automatically and instantly. 
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Step 3. Click Close button when the conversion is completed. 
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61. Convert NTFS to FAT 

62.1 About Convert NTFS to FAT 

NTFS is now used by more and more people since it is a relatively better file system than FAT. 

But in some cases, users still need to convert NTFS to FAT. For example, when the target disk or 

program only supports FAT, users have to do such work. Well then, how to convert NTFS to FAT 

safely? 

In fact, the operations are quite simple as long as users employ MiniTool Partition Wizard. By 

using the Convert NTFS to FAT function, users can finish file system conversion without any 

data damage. 

https://www.minitool.com/lib/file-system.html
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62.2 How to Convert NTFS to FAT 

Please follow the MiniTool Partition Wizard tutorial below to convert file system from NTFS to 

FAT, without bringing any damage to data. 

Step 1. Select the NTFS partition whose file system needs to be converted in Disk Map or 

Disk/Partition/Volume List area. Then choose Convert NTFS to FAT function form the left action 

panel. 

 

Step 2. Click the Apply button in the upper left corner to apply changes. 

Note: Since the Convert NTFS to FAT function owns the capacity of automatic recognition, the 

software will convert an NTFS partition to a FAT 12 partition, a FAT 16 partition or a FAT 32 

partition according to the actual partition size in the process of converting. 

Note: MiniTool Partition Wizard Free Edition does not support this function. To use this 

function, users need to buy a professional edition or more advanced edition. View Edition 

Comparison to know more. 

https://www.partitionwizard.com/comparison.html
https://www.partitionwizard.com/comparison.html
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Step 3. Click on Yes button in the pop-up window to confirm pending changes on partition.  
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Step 4. Wait for all pending operations to complete. Click on OK button to end NTFS to FAT 

conversion when Applied all the pending changes successfully prompt window shows up. 

 

62. Set Partition as Primary  

63.1 About Set Partition as Primary 

As we all know, partitions on an MBR disk can be divided into two types: primary 

partition and extended partition and the latter can be subdivided into several logical partitions. 

What users actually see in disk is logical partition and primary partition. Well, in which situation 

do users need to set partition as primary? How to set a logical partition as primary? 

First of all, we'd like to explain the reason for setting partition as primary. 

If users want to install a second operating system to computer but have no more primary partitions, 

they have to set a logical partition as primary. That is because all the system files and boot files of 

an operating system must be saved to a primary partition and this partition should be different 

from the one that saves files of the original operating system. 

In this article, we are going to give users a MiniTool Partition Wizard tutorial to show how to set 

partition as primary. 

https://www.minitool.com/lib/primary-partition.html
https://www.minitool.com/lib/primary-partition.html
https://www.minitool.com/lib/extended-partition.html
https://www.minitool.com/lib/logical-partition.html
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63.2 How to Set Partition as Primary 

2 main limitations in setting partition as primary on MBR disk: 

1. Users can't finish this task if there are already 3 primary partitions and more than one logical 

partition on the disk (since an MBR disk can support at most 4 primary partitions or 3 primary 

partitions and 1 extended partition). 

2. Even though there are only 1 or 2 primary partitions, users still can't set a logical partition as 

primary if the adjacent partitions of this logical partition are both logical partitions (since MBR 

disk can support at most one extended partition; if this task could be made, there would be 2 

extended partitions on the disk). 

Now, please follow the MiniTool Partition Wizard tutorial given below: 

Step 1. Choose the logical partition that needs to be set as primary partition. Then choose Set 

Partition as Primary directly from left action panel. 

 

Step 2. Click Apply to all the pending operation. 
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Step 3. Tap Yes button to confirm changes on the selected logical partition. 
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Step 4. Tap OK button in the prompt window at the end of the task. 

 

63. Set Partition as Logical  

64.1 About Set Partition as Logical 

One of the biggest limitations of MBR disk is that it can support up to 4 primary partitions (or 

3 primary partitions plus 1 extended partition). Imagine this. users already have 4 primary 

partitions but still need to create more partitions with free space on this disk, users will receive this 

prompt when trying to create new partitions in Disk Management. 

What are users supposed to do to work this out? 

Certainly, the best way to solve this problem is to set partition as logical. After that, users can get 

as many logical partitions as they want by adjusting the size of existing partitions. 

Now, the only obstacle is how to set partition as logical. Considering that users are not familiar 

with such task at all, we feel glad to offer a wonderful tool named MiniTool Partition Wizard. 

Detailed tips can be found in each interface of this tool, so users got nothing to worry about. 

64.2 How to Set Partition as Logical 

https://www.minitool.com/lib/primary-partition.html
https://www.minitool.com/lib/extended-partition.html
https://www.minitool.com/lib/logical-partition.html
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Here’s the MiniTool Partition Wizard tutorial for setting a primary partition as logical; it only 

consists of three steps. 

Step 1. Choose any one primary partition that users want to set as logical from the main interface 

of the software (except for the one that includes system files). Then choose Set Partition as 

Logical function directly from Change Partition list in left action panel. 

 

Of course, users can also activate Set Partition as Logical function through following ways. 

1. right click the target partition -> choose Set Partition as Logical; 

2. select Partition in menu bar -> choose Modify -> choose Set Partition as Logical. 

Step 2. Tap Apply button in the toolbar to execute pending operation immediately. 
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Step 3. Click Yes in the prompt window to allow changes.  
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Step 4. Tap OK button in successful prompt window to end the whole task.  

 

64. Set Active/Inactive  

65.1 About Set Active/Inactive 

When users install system on a hard drive, there will be a system partition. If system partition is 

not set active, Windows will be unbootable, as only setting the system partition active can MBR 

visit the very partition to find Windows boot programs BOOTMGR and Boot Configuration 

Database.  

Normally, if users have added a new disk to computer and finished migrating OS from the original 

disk to the new one, user need to set boot partition on the new disk as active and then set it to be 

the first boot device in order to make computer boot from it successfully. 

Now, the question comes – how to set active/inactive manually when necessary? We'll introduce 

Note: If users use Migrate OS to SSD/HD function of MiniTool Partition Wizard to transfer OS 

to another drive, the software will set the new drive as active automatically at the end of OS 

migration. 
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the method of using Set Active/Inactive in MiniTool Partition Wizard. 

Here is the step-by-step MiniTool Partition Wizard tutorial. 

65.2 How to Set Active 

Note: The following operations are competed with MiniTool Partition Wizard Bootable 

Edition. users can use MiniTool Partition Wizard's Bootable Media Builder feature to create 

bootable CD/DVD/USB flash drive or build an ISO image of a bootable disc. After that, use the 

bootable disk to start computer to get the main interface of MiniTool Partition Wizard Bootable 

Edition. 

Step 1. Select the partition users would like to set as active and choose Set Active from the left 

action panel. 

Kindly Remind: 

⚫ If users are running an MBR disk, only the primary partitions on it can be set active. But if 

the disk is GPT, there's no such limit. 

⚫ One disk can hold at most 1 active partition. 

⚫ If users set the wrong partition as active and change the original active partition into inactive, 

they will be blocked out from Windows system. 

 

https://www.partitionwizard.com/partitionmagic/partition-magic-boot-cd.html
https://www.partitionwizard.com/partitionmagic/partition-magic-boot-cd.html
https://www.minitool.com/boot-from-created-recovery-cd.html
https://www.minitool.com/boot-from-created-recovery-cd.html
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Step 2. Click on Apply button to perform pending operations. 

 

Step 3. Choose Yes from Apply Changes prompt window to confirm.  
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Step 4. Click on OK button when the Successful prompt window shows up so as to end this task. 

 

65.3 How to Set Inactive 

The process to set inactive is very similar to set active. 

Step 1. Select the partition users would like to set as inactive and choose Set Inactive. 
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Step 3. Click on Yes button in Warning window to continue. 
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Step 4. Click on Apply button to perform pending operations. 

 

Step 5. Choose Yes from Apply Changes prompt window to confirm. 
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Step 6. Click on OK button when the Successful prompt window shows up so as to end this task.  

 

65. Initialize to MBR Disk 

66.1 About Initialize to MBR Disk 

We found an increasing number of users now would like to initialize their disk to MBR, due to the 

following reasons: 

⚫ No UEFI option is offered in BIOS, operating system has to be installed on MBR disk. 

⚫ Operating systems like Windows 7 32-bit and Windows Vista 32-bit do not support GPT disk. 

⚫ Some programs do not support GPT disk. 

However, if users need to mount a second operating system to the GPT disk, they may be 

disappointed. The reason is simple – common BIOS system doesn’t support booting from GPT 

disk. In this case, users may need to initialize to MBR disk sometimes so as to keep both 

operating systems. 

Here, we are going to introduce a good tool – MiniTool Partition Wizard to help with this. 
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66.2 How to Initialize to MBR Disk 

If users don’t know how to initialize to MBR disk and never have such experience. Just follow the 

MiniTool Partition Wizard tutorial we give here to complete disk initialization easily: 

Step 1. Enter MiniTool Partition Wizard main interface. And then select Initialize to MBR 

Disk by 

a. clicking on it under Convert Disk. 

b. choosing it from right-click menu of target disk. 

c. clicking on it from the drop-down menu of Disk option in the menu bar. 

 

Step 2. Tap Apply button in the upper left corner to execute pending operations. 
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Step 3. Confirm pending changes by clicking on Yes button in the prompt window.  
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Step 4. Click on OK button in the prompt window that will appear automatically at the end of disk 

initialization.  

 

66. Initialize to GPT Disk  

67.1 About Initialize to GPT Disk 

Adding new hard disk is regarded as a good way to extend the capacity of the computer. With the 

fast development of hardware technology, large-capacity hard disks are becoming increasingly 

common. After a new hard disk with a large capacity is connected to Windows computer, users 

must initialize it to GPT/MBR in order to use it for data storage. 

However, how to finish the disk initialization task easily draws people's attention. What if users 

would like to initialize it to GPT? Compared to MBR, GPT has some advantages: 

⚫ GPT supports at most 128 partitions in Windows, while MBR only supports 4 primary 

partitions or 3 primary partitions plus 1 extended partition. 

⚫ The largest disk capacity that can be managed by GPT mounts to 18EB, while the capacity 

limit of an MBR disk is only 2TB. 

Hot article: MBR VS GPT ( Focus on Difference and How to Convert Safely) 

https://www.minitool.com/lib/gpt.html
https://www.minitool.com/lib/mbr.html
https://www.partitionwizard.com/partitionmagic/mbr-vs-gpt.html
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Thus, many users would like to initialize their disk to GPT. As for how to initialize to GPT disk, 

we recommend using MiniTool Partition Wizard. To make the operating process clear, we will 

give a MiniTool Partition Wizard tutorial. Now, please free download the software and then start 

to initialize to GPT disk. 

67.2 How to Initialize to GPT Disk 

Step 1. Choose the disk that users would like to initialize to GPT and then select Initialize to GPT 

Disk by 

a. clicking on it under Convert Disk from the left action panel. 

b. choosing it from right-click menu of target disk. 

c. clicking on it from the drop-down menu of Disk option in the menu bar.  

 

Step 2. Tap Apply in the upper left corner to perform pending operations. 



 

 

Copyright © 2019 MiniTool® Software Limited, All Rights Reserved. 

 

Step 3. Click Yes in the prompt window to allow changes. Users would better close all other 

applications as suggested. 
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Step 4. Click on OK button at the end of disk initialization. 
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